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Setting Up
Congratulations on purchasing your new Power Mac G4 computer. Your Power Mac G4 is a
full-featured computer that includes the latest in computer technology such as FireWire, USB,
support for AirPort wireless Internet and networking, and the latest Macintosh operating
system, Mac OS X. This chapter contains instructions for setting up your computer and display.
Positioning the Computer and Display
You can pick up the computer by any of its handles. If your monitor (or display) is heavy, be
sure to use correct lifting techniques when positioning it. Position the computer and display
so that
m they are on sturdy, flat surfaces
m the power cable connectors don’t press against a wall or other object
m nothing obstructs air flow behind or below the display or computer
m the computer’s optical drive tray has space to open in front
The only way to shut off power completely to your computer and display is to
disconnect their power plugs from the power source. Make sure the power cords for your
computer and display are within easy reach so you can quickly unplug them if necessary.

Important

7

Plugging In the Computer
1

Set the voltage switch on the back of your computer to the correct voltage, if necessary.
m If your computer doesn’t have a voltage switch, the correct voltage is set automatically
and you can skip this step.
m If your computer has a voltage switch, make sure the voltage switch is set for the voltage
system in your country.
The voltage switch must be set correctly to avoid damaging your computer.
Your computer may have a voltage switch on the back.
If you need to change the setting, insert a small screwdriver
in this slot and slide the switch.

Set the switch to show “115” for AC voltages in
the 100–120V range. Set the switch to show
“230” for AC voltages in the 200–240 V range.
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Country

Switch setting

Bermuda, Canada, Jamaica, Japan, Mexico, Philippines, Puerto Rico,
Saudi Arabia, Taiwan, United States, Venezuela

115

Bahrain, Brazil, France, Indonesia, Italy, Lebanon, Peru, South Korea,
Spain1

115 or 230

Argentina, Australia, Austria, Belgium, Bosnia and Herzegovina, Chile,
China (People’s Republic including Hong Kong), Croatia, Czech
Republic, Denmark, Egypt, Finland, the Former Yugoslav Republic of
Macedonia, Germany, Greece, Greenland, Hungary, Iceland, India,
Iran, Ireland, Israel, Jordan, Kuwait, Liechtenstein, Luxembourg, Malta,
Nepal, the Netherlands, New Zealand, Northern Ireland, Norway,
Oman, Pakistan, Papua New Guinea, Paraguay, Poland, Portugal, Qatar,
Romania, Russia and the Commonwealth of Independent States (CIS),
Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa,
Sweden, Switzerland, United Arab Emirates, United Kingdom, Yemen

230

1

2

These countries employ more than one type of power source voltage. Ask your local power provider which switch setting to
use for your city or region.

Plug the power cord firmly and completely into the recessed power socket marked with the
symbol ≤ on the back of the computer and plug the other end into a grounded outlet or
power strip.

Power cord socket

Power cord plug
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3

Connect your display cables according to the following illustration:
Depending on your monitor, you may have one or more cables to connect.
Check the instructions that came with the monitor for further setup information.
Important

USB ports

Monitor ports

Monitor cable

Your card has an Apple Display Connector (ADC) port for connecting Apple flat panel
displays and a VGA monitor port for connecting most commonly used displays that have VGA
connectors.

ADC monitor port

VGA monitor port

If your monitor cable has a two-row DB-15 connector, you can purchase a Macintosh-to-VGA
adapter from an Apple-authorized dealer and connect your monitor to the VGA port on
the computer.
For more information about connecting a second display, see the guidelines in Chapter 4,
“Using Your Computer.”
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4

If required, connect your computer to your Ethernet network or connect your modem port
to a phone line.

Modem port

Ethernet port

5

Connect the keyboard cable to one of the USB ports ( ) on the computer or on your display.
Plug the mouse cable into a USB port on the keyboard.
Don’t put anything in the recessed
speaker opening. Touching the
speaker can damage it.

USB ports on keyboard (2)

Keyboard

Mouse

Parts of your computer
may be covered by clear
plastic film that protected
it during shipment. You
can remove the film.

Setting Up
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If you wish, raise the keyboard by lifting it and flipping the foot toward the back.

6

Turn on your computer by pressing the power button (®) on the front of the computer.
With some displays, you can also turn on the computer using the display’s power button.
m If your display must be turned on separately, turn it on by pressing its power button.
Need Help?
If you don’t see anything on your screen or you think your computer did not start up
properly, check these items:
m Is the computer plugged into a power source? If it is plugged into a power strip, is the
power strip turned on?
m Are the keyboard and display cables connected correctly?
m Is the power button lit on the front panel of the computer and on the display? If not, the
computer or display isn’t receiving power or is off.
m Is the display turned on? Are the brightness and contrast controls on the display adjusted
correctly? If your display has brightness and contrast controls, adjust them.
m Restart your computer. Press the computer’s power button for approximately 5 seconds
until the computer turns off. Press it again to turn the computer on.
m If you see a blinking question mark on the screen or hear a series of beeps when you turn
on the computer, see Chapter 6, “Troubleshooting,” on page 87.
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When You’re Not Using the Computer
Your computer is set to go to sleep after a period of inactivity. Sleep is a state in which your
computer is on but uses very little power. To wake your computer from sleep, press any key.
You can also put the computer to sleep whenever you want, or set your computer so it never
goes to sleep. For more information on sleep, see “Putting the Computer to Sleep to Save
Energy” on page 63.
If you’re not going to use the computer for a few days, you should turn it off.
To turn off your computer, choose Shut Down from the Apple (K) menu.
Important Do not turn off the computer by turning off the switch on a power strip or by
pulling the computer’s power plug (unless you can’t turn off the computer any other way).
Your files or system software could be damaged if your computer is not shut down properly.

Adjusting Your Display
To adjust the settings for your display, choose System Preferences from the Apple (K) menu
and click Displays.
For information about troubleshooting your display, see “Problems With Your Display” on
page 90. For information about maintaining your display, see “Maintaining Your Display” on
page 104. Additional information about using your display is available in Mac Help.
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Getting to Know Your Computer

Optical drive

Zip drive
(optional)

Power button /
Status light

P Reset button

¥ Programmer’s

button

Media eject key
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Speaker

Optical drive

Your computer has a CD-RW drive, a DVD-ROM/CD-RW drive, or a SuperDrive. All three
kinds of drives can read CD-ROM discs, Photo CDs, standard audio discs, and other kinds
of media. The DVD-ROM/CD-RW drive and SuperDrive can also read DVD discs and DVD
movies and write music, documents, and other digital files on CD-R and CD-RW discs. The
SuperDrive can also write on blank DVD-R discs. To open the optical drive, press the Media
Eject (C) key on your Apple Pro keyboard.
Zip drive (optional)

Store and back up information on removable Zip disks. If you purchased a Zip drive, it is
installed here.

®

Power button/Status light

Press this button to turn on the computer or wake it from sleep. When the computer is on,
press the power button to put the computer to sleep. A white light indicates that the
computer is on. A pulsing light indicates the computer is in sleep.
With some Apple displays, you can also touch or press the monitor’s power button to turn
the computer on or put it to sleep.

P

Reset button

This button forces the computer to restart. Use the reset button only when you cannot
restart your computer with any of the recommended methods, such as choosing Restart
from the Apple (K) menu in Mac OS X, or choosing Restart from the Special menu in
Mac OS 9. For more information about when to use the reset button, see Chapter 6,
“Troubleshooting,” on page 87.

¥

Programmer’s button

This button interrupts the normal operation of the computer’s software. Only use this
button for firmware updates. The firmware update documentation includes directions for
using this button.
Speaker

The recessed internal speaker is designed for optimal sound fidelity. Don’t let anything
touch the fragile speaker mechanism.

C

Media Eject Key

The Media Eject Key on the Apple Pro Keyboard opens the optical drive and ejects CD and
DVD discs.
On some keyboards, you can also use the F12 key to eject discs and open the optical drive.
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Ports and Connectors—Expanding Your Computer’s Capabilities

f Headphone jack

Apple speaker mini-jack

FireWire ports (2)

Lockable cover latch

W Internal modem port
(optional)

≤ Power socket

G Ethernet port
USB ports (2)
VGA monitor port
(Slot 1: AGP)
ADC monitor port

F Security lock port
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Access covers for
expansion slots
(Slots 2–5: PCI)

f

Headphone jack

Connect your Macintosh to headphones, externally powered (amplified) speakers, or other
audio output equipment. For more information about the kinds of speakers you can
connect, go to the Apple World Wide Web site at www.apple.com/store
Apple speaker mini-jack

Connect your Macintosh to high-fidelity Apple Pro speakers to play stereo music and
sound for multimedia, games, audio CDs, and more. See “Adjusting the Sound While
Playing DVD and Audio Discs” on page 55 for information about using your speakers.
FireWire ports

Connect your Macintosh to FireWire devices, including digital video cameras, scanners, and
hard disk drives. FireWire provides a high-speed method of data transfer between them all.
USB ports

Connect your Macintosh to USB devices, such as keyboards, mouse devices, printers,
scanners, speakers, USB microphones, and USB hubs. Your display may also have USB
ports for connecting USB devices.
Monitor ports

Connect your Macintosh to monitors that use the Apple Display Connector (ADC) or to
standard monitors that have a video graphics array ( VGA) connector.

F

Security lock port and lockable cover latch

You can attach a security lock to your Macintosh and to its back panel to secure the
internal components. When the lockable cover latch is pulled out, you can insert a security
cable or lock to prevent the computer cover from opening. See your computer products
retailer for security lock devices that will work with your computer.

W

Internal modem port

Connect a phone cord to the internal modem.

≤

Power socket

Connects to the computer’s power cord.

G

10/100/1000 twisted-pair Ethernet port

Connect your Macintosh to a high-speed Ethernet network so that you can access network
resources, such as printers and servers, and share information with other computers over
the network.
Access covers for expansion slots (4)

Your Macintosh supports up to four peripheral component interconnect (PCI) cards. The
covered slots, labeled 2, 3, 4, and 5, provide additional expansion capability. In some
configurations, an Ultra160 low voltage differential (LVD) SCSI card is installed in one of
these slots.
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Inside Your Power Mac—Your Computer’s Internal Expansion Options

Drive position 3

Slots 2–5: 33 MHz PCI slots (4)

Slot 1: AGP slot
(graphics card installed)
Drive position 2

SDRAM slots (3)

Drive position 1

AirPort Card connector
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Battery

Hard disk drive carriers

You can install additional hard disk drives in these carriers inside your computer. If you are
using ATA hard disk drives, you can install up to two ATA drives in the single U-shaped
carrier (position three). If you are using SCSI hard disk drives, you can install up to three
SCSI drives in the drive carriers.
AirPort Card connector

Connects an AirPort Card, which allows your computer to communicate with a wireless
network.
PCI expansion slots

You can install PCI cards in these slots to expand your computer’s capabilities. For
example, you can install a SCSI PCI card and then connect and use SCSI devices such as
scanners, hard disk drives, and Zip drives.
AGP graphics slot

Connects your advanced graphics port (AGP) card, which provides fast graphics processing
power, to your monitor. Depending on your graphics card, you can connect a monitor that
has an Apple Display Connector (ADC) or a standard video graphics array ( VGA)
connector.
SDRAM slots

You can install additional memory in your computer by inserting up to 3 DRAM DIMMs in
the memory slots. You can expand your computer’s memory up to 1536 MB (1.5 GB).
Battery

Your computer uses a battery that you rarely replace. If you find that your computer is
having trouble starting up, or that the system date and time are frequently incorrect, you
may need to replace the battery. For more information, see “Replacing the Battery” on
page 85.
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What’s Next?
m For an overview of your computer’s software features, see Chapter 2, “Getting Started
With Your Computer,” on page 21.
m For information about your Macintosh operating systems, including instructions on how
to switch between Mac OS X and Mac OS 9, see Chapter 3, “Working With Your Operating
System,” on page 43.
m For more information about using your modem, connecting to a network, or using the
computer’s other hardware features, see Chapter 4, “Using Your Computer,” on page 47.
m For information about installing additional drives, memory, or PCI cards or changing the
computer’s battery, see Chapter 5, “Working Inside Your Computer,” on page 67.
m The Setup Assistant will help you register your new computer with Apple. You can also
register your computer, Apple display, or Apple software on the Apple Web site at
www.apple.com/register

20

Chapter 1

2

C H A P T E R

2

Getting Started With Your Computer
If you’re eager to get started and want to try out a few things, this chapter is for you. It
provides an overview of your computer’s software features along with the unique Internet
services available to Mac owners.
Your computer comes with two Macintosh operating systems installed: Mac OS X and
Mac OS 9. While your computer is set to start up in Mac OS X, you can set it to start up in the
Mac OS you prefer, and then easily switch between the two. For instructions on how to
switch your startup Mac OS, or for more information about the operating systems on your
computer, see Chapter 3, “Working With Your Operating System,” on page 43.
Mac OS X includes powerful features that you can use to connect to the Internet to watch
streaming video, research information, shop, and even update your software automatically.
With your Power Mac G4, you also get some of the latest Apple software for creating
multimedia masterpieces. Connect your digital camera and create your own desktop movies
with iMovie; create a DVD of several iMovies and digital photos using iDVD (if you have a
SuperDrive); or play digital music files with iTunes.
Apple also provides you with free Internet services that give you storage space on the
Internet, a personal Mac.com email address, tools to easily create your own Web site or
iMovie theater, and more.
Note: Because Apple frequently releases new versions and updates to its system software,
applications, and Internet site, images shown in this manual may be slightly different from
what you see on your screen.
For the Latest Information
The Apple Web site links you to technical support, the latest Apple news, free downloads,
and online catalogs of software and hardware for your Mac at www.apple.com
You can also find the manuals for many Apple products on the AppleCare Service and
Support Web site at www.apple.com/support
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About Mac OS X

Apple menu!

Status icons!

Use this to
change settings,
open recently
used items, and
shut down your
computer.!

Check the
status of System
Preferences from
the menu bar.
Finder toolbar!
Click to open
folders, files, and
shortcuts to
places on your
computer.

Sheet!
Sheets for
saving and printing
are attached to
document
windows.

Window with
buttons!
Click a button to
close the window,
minimize it in
the Dock, or
enlarge it.

Button!
If a button pulses,
you can press the
Enter or Return
key instead of
clicking it.

Dock!
Click an icon in the Dock to open
that item or make it active. Some
icons in the Dock indicate the
status of an application.!
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What You Can Do

Mac OS X provides a powerful and elegant new user interface for your computer. With
Mac OS X, you don’t need to worry about the amount of memory to allot for an application
to run efficiently, or restarting your computer if something goes wrong with an application.
In addition to using Mac OS X software, you can still run Mac OS 9 versions of software in
Mac OS X thanks to the Classic environment. Chapter 3, “Working With Your Operating
System,” on page 43 explains Classic in more detail. Mac OS X also supports Java™ and
UNIX-based software.
To Get Started

System Preferences is your command center for all of your computer settings, from changing
the appearance of your desktop to setting up network access information. The Finder and
Dock provide easy access to folders, applications, documents, and other items on your
computer and network.
For details on the features of Mac OS X, see the Welcome to Mac OS X book that came with
your computer or choose Mac Help from the Help menu in Mac OS X.
Tips and Tricks
Personalize the Finder

Select a picture or color for your Desktop by choosing System Preferences from the Apple
(K) menu and clicking the Desktop pane. You can drag an image to the well or select one
from the Apple Background Images collection.
Personalize the Dock

You can change the size of the Dock icons and turn on magnification so that the icons under
your pointer become larger than the rest of the Dock. Choose Dock from the Apple (K)
menu, then choose Dock Preferences. You can also open System Preferences from the Apple
(K) menu and click Dock.
Keep your desktop organized

Reduce the clutter on your desktop by minimizing open windows, which puts them in the
Dock. Double-click a window’s title bar or click the middle button in the top-left corner of
the window to put it in the Dock. Click the window’s icon in the Dock to open it again.
To Learn More

For instructions on how to customize your Mac OS X environment and for more information
about using Mac OS X, see the Welcome to Mac OS X book that came with your computer.
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Sherlock—Your Internet Search Detective

Sherlock channels!
Search the Internet for
people, shopping, news,
Apple info, and more.

Search button!
After you type what
you are looking for,
click this button to
start the search.
Search sites!
Sherlock searches
the Internet using
several search
engines.

Sherlock icon!
Click the Sherlock
icon in the Dock.
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What You Can Do

Sherlock is your search detective and personal shopper on the Internet. It provides an easy
way to find people, news, and just about anything. Shop for books and music and search
auction sites, find the best prices—even check product availability.
To Get Started
1

Connect to the Internet.

2

Open Sherlock by clicking the Sherlock icon in the Dock. You can also choose Find from the
File menu to find files on your computer.

3

Select a Sherlock channel.

4

Type what you are looking for and click the Search button.
Tips and Tricks
Create your own customized Sherlock search channel

1

Choose New Channel from the Channels menu.

2

Select a name, channel type, and icon.

3

Download Sherlock plug-ins and drag them into the Search Sites list. Or hold down the
Option key and drag plug-ins from other search lists to the icon of your new channel.
To Learn More

To learn more about what you can do with Sherlock, open Mac Help and search for
“Sherlock.” To download additional search plug-ins and find out how you can create your
own Sherlock plug-in, go to the Sherlock Web site at www.apple.com/sherlock
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iTools—Free Internet Services for Mac Users

26

Email!

iCards

Get your own Mac.com email address.
It’s easy, and it works with your favorite
email programs.

Send an elegant iCard, just right for any
occasion. Choose a ready-made photo,
or create a personalized iCard using
photos on your iDisk.

iDisk

HomePage!

Your own 20 MB of free storage
on Apple’s Internet server. Share photos,
movies, and other files over the Internet.
Purchase additional storage space.

Build a personal Web site in three easy
steps. Create a photo album, publish an
iMovie, post your résumé, and more.
Now anyone can view your page on the
Internet.

Chapter 2

What You Can Do

iTools is a new class of Internet services from Apple created exclusively for Mac users. With
iTools, you can send email or greeting cards to your friends, make the Internet safer for your
children, and share photos and movies. You can even create your own Web site.
To Get Started
1

Connect to the Internet.

2

Go to www.apple.com

3

Click the iTools tab and then click the Free Sign Up button.
Tips and Tricks
Upload pictures to your iDisk to create custom iCards

You can send iCards with your own custom pictures. Save your images as GIF or JPEG files
and then copy them to the Pictures folder on your iDisk. Your images will appear as picture
choices when you create an iCard in the Create Your Own section.
Start with a HomePage template to create your own Web page in minutes

HomePage has Web page templates that you can modify with your own text and images. For
example, teachers can use the HomePage education templates to post recent class news,
homework assignments, and other information for parents. You can also use the HomePage
photo album and iMovie templates to share your pictures and movies easily with your friends
and family.
Create an alias of your iDisk for easy access

Instead of using a Web browser to open your iDisk, choose iDisk from the Go menu. You can
also add an iDisk icon to the Finder toolbar. Choose Customize Toolbar from the View menu,
then drag the iDisk icon to the Finder toolbar and click Done.
Use iTools to control access by other users

Set up your computer so that each member of the family can log in. See “Multiple Users—
One Mac for Many Users” on page 40 for information about setting up your computer for
several users.
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Apple.com—Your Starting Place on the World Wide Web

Macintosh
Macintosh
ProductsGuide
Guide
Products

www.apple.com/guide!
www.apple.com/guide!
For great hardware and software
For great hardware and software
products for your Mac, check
products for your Mac, check
this Web site or look for
this Web site or look for
the Mac symbol.
the Mac symbol.

AppleSoftware
Software
Apple

www.apple.com/software!
www.apple.com/software!
Search by category for Apple
Search by category for Apple
software for your Mac.
software for your Mac.

TheApple
AppleStore
Store
The

store.apple.com!
store.apple.com!
Purchase the latest
Purchase the latest
Apple hardware, software,
Apple hardware, software,
and accessories.
and accessories.
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Mac OS X
www.apple.com/macosx/!
Get the latest on the world’s most
advanced operating system.

Apple Hot News
www.apple.com/hotnews!
Find information on the latest
software updates for your Mac,
third-party software, QuickTime
Hot Picks, and information on
the next big Apple event.

Apple Support

www.apple.com/support!
Find information about the
AppleCare Protection Plan,
training programs, and other
product support. Also access
software updates, the
Apple Knowledge Base, and
technical information.
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QuickTime—Audio and Video on the Internet

Volume control

QuickTime TV!
Click to view the
QuickTime TV
channels you can
access on your
computer.

QuickTime icon!
Click the QuickTime
icon in the Dock.
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What You Can Do

In addition to playing video and music files on your Mac, with QuickTime you can watch live
and recorded Internet broadcasts. Store channels that you frequently view by dragging them
to your personal list of QuickTime Favorites (♥).
To Get Started
1

Connect to the Internet.

2

Open QuickTime Player by clicking the QuickTime Player icon in the Dock. You can also
double-click QuickTime Player in the Applications folder.

3

Select a channel or choose an option from the QuickTime Player menu. QuickTime TV uses
Internet streaming, so you get the latest video, music, and information over the Internet
without having to store files on your hard disk.
You can view your QuickTime Favorites (♥) by choosing Favorites from the QTV menu, then
choosing Show Favorites from the submenu.
Tips and Tricks
Add additional QuickTime TV channels

Go to www.apple.com/quicktime and click the QuickTime TV link. There you will find all of
the available QuickTime channels. You can watch a QuickTime TV (QTV ) channel and with
one click add it to your QuickTime Favorites list.
Upgrade to QuickTime Pro to do the following:

m
m
m
m

Play back full-screen video and resize movies.
Create streaming movies.
Work with more than 30 audio, video, and image formats, including Flash.
Create, open, edit, and save movies and audio as easily as copying and pasting.

To Learn More

Internet video is just one of the things you can do with QuickTime. To learn more, start with
QuickTime Help. To download additional channels or find information on setting up your
own Internet streaming server, go to the QuickTime Web site at www.apple.com/quicktime
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iMovie—Create and Edit Your Own Digital Movies

iMovie monitor!
Preview your
movie or view
video directly from
a connected DV
camcorder.

Shelf!
To make clips part
of your movie after
you import them,
drag them from
the shelf to the
clip viewer.

Mode switch!
Use this to
switch between
importing from
a camcorder
and editing.

Editing
buttons!

Clip viewer!
Timeline
viewer!
The clip viewer
and the timeline
viewer are
visual aids for
assembling and
editing your
movie.

Playback controls!

Scrubber bar!

Use these to play the
movie in the iMovie
monitor.

Use this to select
sections of video.

Video track!
Lets you work
with audio
contained in
video clips.
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Audio tracks!

Playhead!

Lets you work with
recordings, music, and
sound effects.

Represents the
location of the frame
showing in the iMovie
monitor. Move the
playhead to see
where things appear
in a movie.

Click these to
open panels for
adjusting and
selecting sounds,
video effects,
titles (text), and
transitions. Click
the Clips button to
see the shelf.

What You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital
video camcorder, you can create and edit your own movies. Import video from the camera;
edit clips; and add transitions, titles, sound effects, and music. Then copy the movie to a
camcorder tape or create a QuickTime movie. You can even share your QuickTime movies by
placing them on the Web on your Apple iDisk or HomePage.
Your computer comes with iMovie for Mac OS X and Mac OS 9.
To Get Started
1

Shoot your video, then connect the camera to your computer’s FireWire port.

2

Open iMovie in the iMovie folder (located in the Applications folder).

3

Click the Import button to import movie clips to the shelf, then add them to your movie by
dragging them to the clip viewer.

4

Assemble and edit your movie in the clip viewer and timeline viewer.

5

Add transitions, titles, sound, and music.

6

When you are finished, choose Export from the File menu.
Tips and Tricks
Share your desktop iMovie with your friends and family

Export your movie as a QuickTime Web movie and copy the movie to your iDisk.
Then use HomePage to create your own iMovie theater so that others can view your movie
on the Internet.
To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the
latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible
DV camcorders, go to the iMovie Web site at www.apple.com/imovie
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iDVD—Create and Burn Your Own DVDs

Movies!
Movies!
To add a movie,
To add a movie,
simply drag it
simply drag it
to iDVD. You can
to iDVD. You can
use movies you
use movies you
created in iMovie.
created in iMovie.

Themes!
Themes!
Choose a
Choose a
background
background
for your DVD
for your DVD
from the
from the
included
included
themes, or
themes, or
customize
customize
your own
your own
theme.
theme.

Burn!
Burn!
Insert a DVD-R
Insert a DVD-R
disc and click
disc and click
Burn. You can
Burn. You can
work on your
work on your
computer while
computer while
the DVD is being
the DVD is being
created in the
created in the
background.
background.

Multiple
Multiple
menus!
menus!
Click the
Click the
Folder
Folder
button to
button to
add multiple
add multiple
DVD menus.
DVD menus.
Slideshow!
Slideshow!
Click Slideshow and
Click Slideshow and
drag still pictures to
drag still pictures to
iDVD. Your DVD can
iDVD. Your DVD can
hold thousands of
hold thousands of
pictures.
pictures.
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Preview!
Preview!
Click Preview to see
Click Preview to see
what your DVD will
what your DVD will
look like.
look like.

What You Can Do

If your Power Mac G4 came with a SuperDrive, you can use iDVD to burn DVDs on blank
DVD-R discs. You can turn your iMovies, digital photos, and other QuickTime media files into
DVDs that can be played on most standard DVD players.
To Get Started
1

If you are using iMovie or Final Cut Pro, export your movies as QuickTime movies.
See iDVD Help for instructions on preparing your movies to work with iDVD.

2

Open the iDVD application in the iDVD folder (located in the Applications folder).

3

Assemble your DVD. Drag your movie files from the Finder to the iDVD window.

4

Click Theme and choose a design for your DVD.

5

Preview your iDVD using the preview remote.

6

When you are ready to burn your DVD, click the Burn DVD button.
Tips and Tricks
Customizing the design of your DVD

You can design the look and feel of your DVD by choosing from the iDVD themes or by
importing your own pictures. You can create a custom button image or background simply by
dragging images onto a button or into the background. Click Theme to further customize
other design elements of your DVD, such as button shapes, title styles, and button label text.
To Learn More

For more information on using iDVD, including where you can buy DVD-R discs, see iDVD
Help or go to the iDVD Web site at www.apple.com/idvd
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iTunes—Digital Music for Your Mac

Search!

Library!

Type some text and
iTunes lists song
titles that match.

Your collection of
songs, imported
from your own audio
CDs or downloaded
from the Internet.
Easily browse or
search for music.!
!
iPod!

Playlists!
Make personalized
playlists using
songs from your
Library. Arrange
your music by
mood, artist,
genre, or
however you like.

Sync with your iPod
and automatically
update songs
and playlists.!
!
Radio Tuner!
Choose from
hundreds
of Internet radio
stations—jazz, rock,
talk, and more.
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Eject CD
button
Audio CDs!
Play an audio CD on your
computer. Import songs to
your library to play them
without the CD.

Equalizer!
Adjust the sound
to your tastes using
the 10-band EQ.

Visuals button!
Have iTunes display
a stunning light show that changes,
throbs, and pulses to the beat of
your music. Enjoy different colors
and patterns every time you
listen to a song.

What You Can Do

iTunes lets you import songs from music CDs as MP3 files, create your own iTunes library,
listen to hundreds of radio stations on the Internet, and more. Create playlists and move
music to your portable MP3 player, or burn your own music selections on CD-R discs.
Your computer comes with iTunes optimized for Mac OS X and a version for Mac OS 9.
To Get Started
1

Open iTunes in the iTunes folder (located in the Applications folder).

2

Insert a music CD into your optical drive.

3

Click the checkbox next to the songs you want to import.

4

Click the Import button. Your songs are converted into MP3 files and stored in your iTunes
library.
Tips and Tricks
Create playlists for your favorite sets of songs

A playlist is a list of songs in a specific order. Click the New Playlist button and drag songs
from your iTunes library to the playlist.
Resize the iTunes window or access iTunes from your desktop

Collapse the iTunes window to show just the playback controls and status. Click the zoom
box in the upper-right corner of the iTunes window. You can also access iTunes controls from
the iTunes portion of the Control Strip (in Mac OS 9) or the Dock (in Mac OS X).
Look up CD information from CDDB

iTunes automatically connects to the CDDB database on the Internet for information about
each song on the CD, then stores it in your iTunes library.
Connect your computer to your stereo system

Use a miniplug-to-RCA cable (not included) to connect the headphone jack (f) on your
computer to the audio input ports on your stereo.
To Learn More

For more information on using iTunes, see iTunes Help or go to the iTunes Web site at
www.apple.com/itunes
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Software Update—Automatically Keeping Your Mac on the Cutting Edge

Update software!
Set how often your computer
checks for software updates
from Apple.

Update Now!
Click to check instantly for updates
available for your Apple software. Select
the Apple software you want to update
from the list that appears.
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What You Can Do

Software Update uses the Internet to automatically download and install the latest software
versions, drivers, and other enhancements from Apple. Use Software Update to instantly
check Apple’s Internet servers to see if any updates are available for your Apple software. You
can even set your Mac to check the Apple server periodically and download and install
updated software for you.
To Get Started
1

Connect to the Internet.

2

Open System Preferences and click Software Update.

3

Click Update Now, then select the software updates you want and click Install.
Tips and Tricks
Adjust your Software Update schedule

If you have an Internet connection that is always on, you can set a schedule for your
computer so that it checks for software updates at a certain time on specific days of the
week. If you have a dialup connection and you are not connected, Software Update will
check the next time you connect.
Install new software automatically

You can set up your Mac so that every week it checks for and installs the latest software. Set a
schedule for your computer to check for software updates and deselect the “Ask me before
downloading new software” checkbox.
To Learn More

For more information on using Software Update, search for “Software Update” in
Mac Help. For the latest information on the Mac OS, go to the Mac OS Web site at
www.apple.com/macos
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Multiple Users—One Mac for Many Users

Users!
Use the Users pane in
System Preferences to
add user accounts.

Home!
Each user has a home.
Finder, Dock, iTools,
Mail, and other
preferences are kept for
each user in the user’s
home, so users can
customize Mac OS X
the way they want.
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Shared folder!
To give access to the
Shared folder, a user can
turn on file sharing in
Sharing preferences.

What You Can Do

Several people can share a single computer by logging in to their individual user accounts.
Users can select their own customized settings, such as bookmark and desktop views, and
access their own private storage space, called a Home folder. Users sharing the computer
also have access to a common Shared folder.
The first user account created on your computer is designated an administrator.
Administrators are users with special privileges: they can give new users access to the
computer, install software, and change general computer settings.
Note: If you forget the administrator password, you can reset it using the Mac OS X CD.
Start up from the Mac OS X CD and choose Reset Password from the Installer menu. Because
a user with the Mac OS X CD can gain unrestricted access to the computer, you should keep
the CD in a safe place.
To Get Started
1

Create a new user by choosing System Preferences from the Apple (K) menu, clicking Users,
then clicking New User.

2

Edit the user’s information. You can give a user administrative privileges.

3

Close the window.
Tips and Tricks
Keeping your computer secure

You can require a password to access the computer after the screen saver appears in case
users log in and leave the computer unattended. Open System Preferences, click Screen
Saver, and click Activation to select the period of inactivity before the screen saver starts.
Then select “Use my user account password.”
To Learn More

For more information on setting up user accounts in Mac OS X, search for “users” in
Mac Help.
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Mac Help—Answers to Your Macintosh Questions

Search!
Got a question?
Type it here and
click Ask.
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Working With Your Operating System
An operating system, or OS, is your computer’s desktop environment that defines how the
items on your desktop are represented and how you interact with them. Each OS has a
different look and feel.
About Mac OS X
Your computer is set to start up in Mac OS X so you can use its advanced technologies, such
as the elegant new user interface, incredible graphics capabilities, and added system stability
and performance. Mac OS X takes care of managing your computer processes so you can
concentrate on what you want to do. You don’t need to worry about restarting your
computer if something goes wrong with one software application. Mac OS X shuts down just
that application so you can keep working without interruption. The Mac OS X virtual
memory manager takes care of allotting the amount of memory your software applications
need to run efficiently.
When you’re ready to learn more about Mac OS X, read the Welcome to Mac OS X book in
your accessory kit. Welcome to Mac OS X introduces the features of Mac OS X and provides
tips for Mac OS 9 users on how to use Mac OS X to perform common Mac OS 9 tasks. If you
experience any problems while learning about Mac OS X, see the troubleshooting tips in the
back of the Welcome to Mac OS X book or choose Mac Help from the Help menu in Mac OS X.
Because Mac OS X is already installed on your computer, you don’t need to
follow the installation instructions in Welcome to Mac OS X. Instead, follow the instructions
in Welcome to Mac OS X to log in and begin using Mac OS X.
Important

You can read more about Mac OS X on the Web at www.apple.com/macosx/
Information About Software and Mac OS X

For information about the compatibility of software applications with Mac OS X, check the
Apple Web site at guide.apple.com/macosx/
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Using Classic in Mac OS X
In addition to using Mac OS X applications, you can continue to use Mac OS 9 applications in
the Classic environment. Classic works in the background to access Mac OS 9 features and
software applications. When you start up Classic, Mac OS 9 software works in Mac OS X just
as it does in Mac OS 9, although it doesn’t benefit from Mac OS X features such as the look of
the new interface. Simply open a Mac OS 9 application or double-click a document created in
a Mac OS 9 application. If Classic isn’t running, it starts up.
Classic continues to run in the background, even if no Classic applications are open, so that
Mac OS 9 applications and documents open faster and more easily. You can set your
computer to start up Classic automatically when you log in to Mac OS X. Choose System
Preferences from the Apple (K) menu, click Classic, and select “Start up Classic on login to
this computer.”
To quit the Classic environment, click Force Quit in the Classic pane of System Preferences.
You can also choose Force Quit from the Apple (K) menu, select Classic Environment in the
list, and click Force Quit.
Do not remove the Mac OS 9 operating system from your computer. For Classic
to work, Mac OS 9 must be installed.
Important

Switching Between Operating Systems
Some tasks and software applications have not yet been optimized to work with Mac OS X or
Classic and perform best in Mac OS 9. You can set your computer to start up in Mac OS 9 and
change the Mac OS your computer uses when it starts up as often as you like.
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To set your computer to start up in Mac OS 9 from Mac OS X:

1

Choose System Preferences from the Apple (K) menu and click Startup Disk.

Note: Because Apple frequently releases new versions and updates to its system software,
the version number of the Mac OS X and Mac OS 9 operating systems in this manual may be
different from those installed on your computer.
2

Select the Mac OS 9 folder as your startup System Folder. (If the icons are dimmed, click the
lock icon at the bottom of the pane and type the user name and password that you created
previously in the Setup Assistant. See Welcome to Mac OS X for more information about
logging in as an administrator.)

3

Restart your computer.
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To set your computer to start up in Mac OS X from Mac OS 9:

1

Choose Control Panels from the Apple (K) menu, then choose Startup Disk.

2

In the Startup Disk control panel, double-click the hard disk that contains your operating
systems and select the Mac OS X System folder as your startup disk. You can click the triangle
to the left of the hard disk icon to see the System folders installed on it.

3

Restart your computer.

Note: Because Apple frequently releases new versions and updates to its system software,
the version number of the Mac OS X and Mac OS 9 operating systems in this manual may be
different from those installed on your computer.
Need Help?
For more information about the features of your Macintosh, choose Mac Help from the Help
menu and click any of the blue underlined text. You can also type a question in the Search
field and press Return on the keyboard.
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Using Your Computer
This chapter provides explanations and instructions for using the important features of your
Power Mac G4 computer, including your keyboard and mouse, modem, FireWire ports, USB
ports, and networking.
Explanations are provided for
m “Using Your Apple Pro Keyboard and Apple Pro Mouse” on page 48
m “Connecting a Second Display to Your Computer” on page 50
m “Using USB Devices” on page 51
m “Using FireWire Devices” on page 53
m “Using Your Optical Drive” on page 55
m “Using Your Modem” on page 58
m “Connecting to an Ethernet Network” on page 59
m “Using AirPort Wireless Networking” on page 61
m “Putting the Computer to Sleep to Save Energy” on page 63
m “Attaching SCSI Devices to Your Computer” on page 64
m “Transferring Information Between Two Macintosh Computers” on page 64
m “Using the Computer as a Server Without a Monitor” on page 65
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Using Your Apple Pro Keyboard and Apple Pro Mouse
Your Apple Pro Keyboard comes with function keys preset for common tasks. Use the Media
Eject key to eject optical disks. Press the Volume Up or Volume Down keys to adjust the
sound level, or press the Mute key to turn sound off. You can also adjust an Apple display’s
level of brightness with the Brightness Up and Brightness Down keys.
Brightness Down key
Function keys

Brightness Up key

- Volume Up key

Volume Down key

Media Eject key

— Mute key

Note: If you’re using a non-Apple keyboard with your computer, use the F12 key to eject
optical disks.
Customizing Function Keys (Mac OS 9)

In Mac OS 9, you can set unassigned function keys (F7–F12) on your Apple Pro Keyboard to
open applications such as your Web browser, email program, or frequently used documents.
Once applications are open, you can use the customized function keys to switch quickly
between them.
The first time you press an unassigned function key, a dialog box appears that lets you assign
any of the function keys to an application or document. You can change the application
assigned to a function key using the Keyboard control panel.
Note: You can’t customize function keys in Mac OS X.
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Using Your Apple Pro Mouse

To position the pointer using your mouse, move the mouse over any suitable surface such as
your desktop, mouse pad, or other textured surface. (Some smooth, glassy surfaces provide
less pointer control than others.) To click an object, press down once on the mouse body
until you feel a click. To double-click an item, press down twice in quick succession.
If you run out of room and want to
keep the mouse clicked while you
lift it, click the mouse, then squeeze
the sides with your thumb and
fingers as you lift.

You can adjust the feel of your mouse by turning the dial underneath. Turning the dial one
direction makes the feel of clicking the mouse stiffer; turning it the other way makes clicking
the mouse easier.
Turn the ring on the bottom of the mouse to “+” for more
tension, “O” for medium tension, and “– ” for less tension.

For More Information About Your Keyboard and Mouse

Additional information on configuring the keyboard controls and customizable function
keys is available in Mac Help. Choose Mac Help from the Help menu and search for
“keyboard” or “mouse.”
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Connecting a Second Display to Your Computer
You can connect two displays to your graphics card and use both displays at the same time.
When a second display is connected, you can either have the same image appear on both
displays (known as mirroring) or use the second display to extend the size of the Mac OS
desktop (known as extended desktop mode).You need a video cable for each display you
want to connect.
To use multiple displays:
1

Turn off the displays and shut down your computer.

2

Connect the video cable from each display to the appropriate port on the graphics card.

3

Turn on the displays and start up your computer.
To adjust the displays, choose System Preferences from the Apple Menu and open the
Displays pane.
For optimal mirroring performance, set both displays to the same resolution
and color depth.
Important

By default, your computer starts up in extended desktop mode. To work in video mirroring
mode, turn Video Mirroring on with the Displays icon in the menu bar in Mac OS X. You can
press the Command (x) key and the F1 key to switch between video mirroring and extended
desktop mode.
For More Information on Displays

For information about connecting your display, see the setup instructions in Chapter 1,
“Setting Up.”
Additional information on using and configuring an external display is available in Mac Help.
Choose Mac Help from the Help menu and search for “display.”
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Using USB Devices
Your Power Mac G4 comes with two USB ports which you can use to connect many
types of external devices, including printers, digital cameras, microphones, game pads,
joysticks, keyboards, mouse devices, and storage devices. USB makes it easy to connect
external equipment. Once you connect the device, it is ready to use. You don’t need to
restart your computer.

USB ports (2)

To use a USB device with your computer, connect the device to the computer and install its
software or configure your computer to work with the device. From then on, your computer
automatically loads the correct software whenever you attach the device.
Note: Apple has already included software to work with many USB devices. In most cases
you do not need to install the software that came with the device. If, when you connect a
USB device, your Power Mac G4 cannot find the correct software, it asks you to search the
Internet to find it.
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Connecting Multiple USB Devices

Your Power Mac G4 has two USB ports. Your keyboard or monitor may also have an available
USB port that you can use to connect devices. If you want to connect more devices, purchase
a USB hub. The USB hub connects to an open port on your computer and provides
additional USB ports (usually four or seven).

USB hub

For More Information on USB

Additional information on USB is available in Mac Help. Choose Mac Help from the Help
menu and search for “USB.” You can also find information on Apple’s USB Web site at
www.apple.com/usb
For information on USB devices available for your computer, go to the Macintosh Products
Guide at www.apple.com/guide
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Using FireWire Devices
Your computer has two FireWire ports. FireWire is a high-speed data transfer system that lets
you easily connect and disconnect external devices—such as digital video (DV ) cameras,
printers, scanners, and hard disks. You can connect and disconnect FireWire devices without
restarting your computer.

FireWire ports (2)

These are some of the things you can do with FireWire:
m Connect a digital video camera and capture or transfer high-quality video directly to your
computer. Then you can use video-editing software such as Apple’s iMovie to edit the
video.
m Connect an external FireWire hard disk drive and use it to back up data or transfer
files. If you have installed software for your FireWire hard disk, the FireWire disk icon
appears on your desktop after you connect the disk drive to your Power Mac G4. Some
FireWire hard disks get their power through the FireWire cable, so you don’t need to
connect an external power supply.
m If you have a problem with your computer that prevents you from starting up or you want
to transfer files, you can use FireWire to connect your Power Mac G4 to another computer
so that your Power Mac G4 appears as an external hard disk on the other computer (a
feature known as “FireWire target disk mode”). See “FireWire Target Disk Mode” on
page 54 for more information.
To use a FireWire device with your computer, connect the device to the computer and install
any software that came with the device. Your computer automatically senses when you attach
a new device.
To start up from a FireWire hard disk that has the Mac OS on it, choose System Preferences
from the Apple (K) menu, click Startup Disk, then select the FireWire hard disk as the
startup disk.
If your FireWire hard disk doesn’t appear or can’t be selected, consult the FireWire hard disk
vendor for updated software drivers.
To disconnect your FireWire hard disk safely, drag its icon to the Trash before disconnecting
the FireWire cable.

Using Your Computer

53

FireWire Target Disk Mode

You can use FireWire to connect your Power Mac G4 to another computer and then have it
appear as an external hard disk on that computer. You can then share or transfer files.
The computer you connect your Power Mac G4 to must have FireWire version
2.3.3 or later installed. Use Apple System Profiler (located in the Utilities folder, in your
computer’s Applications folder) to check the version of FireWire installed. If you have an
older version, check for an update at the Apple FireWire Web site at www.apple.com/firewire
Important

To connect your Power Mac G4 in FireWire target disk mode, follow these steps:
1

Shut down your Power Mac G4.

2

Use a FireWire cable with a 6-pin connector on each end to connect your computer to
another FireWire-equipped computer.

3

Start up your Power Mac G4 and immediately hold down the T key.
Your Power Mac G4 display shows the FireWire disk mode indicator, and the Power Mac G4
internal hard disk icon appears on the desktop of the other computer.

4

When you are finished transferring files, drag the Power Mac G4 hard disk icon to the Trash
to unmount the drive.

5

Press the power button on the Power Mac G4 to shut it down and then disconnect the
FireWire cable.
For More Information on FireWire

Additional information on FireWire, including setting up a network of FireWire devices, is
available in Mac Help. Choose Mac Help from the Help menu, and search for “FireWire.”
You can also find information on Apple’s FireWire Web site at www.apple.com/firewire
For information on the FireWire devices available for your computer, go to the Macintosh
Products Guide at www.apple.com/guide
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Using Your Optical Drive
You can install or run software from CDs using your optical drive. You can play multimedia on
CD discs and music from audio CDs. Your optical drive can also write music, documents, and
other digital files on CD-R and CD-RW discs. If you have a DVD-ROM/CD-RW drive or a
SuperDrive, you can also play DVD movies and use most DVD discs. SuperDrives can also
record information on blank DVD-R (recordable DVD) discs.
Note: If you have older software that comes on floppy disks, contact the software
manufacturer to see if the software is available on a CD or purchase an external USB
floppy disk drive for your Power Mac G4 from your Apple dealer or the Apple Store
(www.apple.com/store).
Inserting a Disc

To install or use programs from a CD or DVD, follow these steps:
1

With the computer turned on, press the Media Eject (C) key on your Apple Pro Keyboard to
open the drive.

2

Place a disc in the tray, with the label facing up, and make sure the disc is lying flat.

3

Gently push the tray in to close it.

4

When the icon for the disc appears on the screen, the disc is ready to use.
Ejecting a Disc

You can eject a disc by dragging the disc icon to the Trash, or by pressing the Media Eject (C)
key on your Apple Pro Keyboard. You can also eject a disc by holding down the mouse button
while restarting your computer.
Adjusting the Sound While Playing DVD and Audio Discs

Repeatedly press the volume keys (-, –) on your keyboard to adjust speaker volume. You
can also adjust speaker volume and balance from your computer by choosing System
Preferences from the Apple (K) menu and clicking Sound.
When you attach Apple Pro speakers or headphones to your computer, the internal speaker
does not output sound.
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Recording Information on a CD

Your drive can record your favorite music, programs, and files on CD-R and CD-RW discs.
You can create your own music CDs and play them on any standard audio player. You can
also record computer files, such as applications, documents, or other digital files, on a
recordable CD.
With a CD-R disc (CD-Recordable), you can record information on the disc once. Although
you can’t change the recorded information, you may be able to add more information until
the disc is full, depending on the application you use. See the documentation that came
with your application for specific information about recording on your CD-R disc. It is best
to use CD-R discs for recording audio CDs, because most audio CD players cannot read
CD-RW discs.
With a CD-RW disc (CD-Rewritable), you can save and change information on your CD
multiple times. However, some software for recording media files on CDs, such as the iTunes
Disc Burner feature, can record data on the disc only once.
You can record music on CD-R or CD-RW discs right from your iTunes library.
1

Open iTunes, located in the Dock in Mac OS X.

2

Select the music you want to record.

3

Insert a blank CD-R or CD-RW disc.

4

Click Burn CD from the top of the iTunes window.
You can also record data on CD-R and CD-RW discs with Disc Burner.

1

Insert a blank disc in the CD drive.

2

In the dialog box that appears, enter a name for the disc and select the format you want to
create. An icon for the CD appears on the desktop.

3

Drag files and folders to the icon.

4

Select the disc and drag the CD icon to the Burn CD icon in the Dock in Mac OS X.
For information about how to use iTunes to record music files on a CD, see the online help
for iTunes in the Help Center.
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Recording Information on a DVD

If you have a SuperDrive, you can author your own digital movies on a blank DVD-R
(DVD-Recordable) disc. You can also record other kinds of digital data, such as backing
up files onto DVD-R discs. However, once you record information on a DVD-R disc, it cannot
be overwritten.
With applications like iDVD or DVD Studio Pro, you can create your own customized DVD,
burn it on a blank DVD-R disc, and play it on most standard DVD players.
When you are finished with an iDVD project, you can write it to a blank DVD-R disc.
1

Launch iDVD and open your completed DVD project.

2

Click the Burn button.

3

Insert a new blank DVD-R disc into the drive when prompted.

4

Click the Burn button again.
You can also record data on DVD-R discs with iDVD.

1

Insert a blank DVD-R disc in the drive.

2

In the dialog box that appears, enter a name for the disc and select the format you want to
create. An icon for the DVD appears on the desktop.

3

Drag files and folders to the icon.

4

Select the disc and drag the DVD icon to the Burn DVD icon in the Dock in Mac OS X.
For more information about how to use iDVD, see the online help for iDVD in the Help Center.
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Using Your Modem
Your Macintosh may come with an Apple 56K internal modem installed.
To connect the Apple 56K internal modem, plug one end of a phone cord into the modem
port on the back of the computer and the other end into a standard RJ-11 telephone wall jack.
Modem port icon

Modem port

Make sure you connect the internal modem to an analog phone line—the kind
used typically in homes. The modem will not work with a digital phone line.
Important

Connecting to the Internet Via a Service Provider

Before you can connect to the Internet using your modem, you must record your service
provider information in the Network Preferences of the Mac OS X System Preferences. When
you first start up your computer, the Setup Assistant guides you through recording these
settings. To record or change these settings later, do the following:
1

Choose System Preferences from the Apple (K) menu and open the Network pane.

2

Click the PPP tab and enter information about your service provider account.

3

Click the Modem tab, choose the modem settings you want, and click Apply Now.

4

Close the System Preferences panel.
Your computer is now set up to connect with your service provider. You don’t need to enter
these settings again.
To establish a connection with your service provider:
m Open the Internet Connect application in your Applications folder and click Connect.
More information about the internal modem is available in Mac Help.
Disconnect your modem from the phone jack during lightning or thunder
storms. This will prevent a voltage overload from damaging the modem.
Warning

Using an External USB Modem

To connect an external USB modem, use a USB cable to connect the modem to an available
USB port on the keyboard, computer, USB monitor, or USB hub.
Check the documentation that came with the modem to see if it needs to be plugged into a
power outlet. Also look for instructions about installing modem software and connecting the
modem to a telephone line.
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Connecting to an Ethernet Network
Your computer comes with built-in 10/100/1000 megabit per second (Mbps) twisted-pair
Ethernet networking capability. Connecting to a network gives you access to other
computers. You may be able to store and retrieve information; use network printers,
modems, and electronic mail; or connect to the Internet. You can also use Ethernet to share
files between two computers or set up a small network.
If you’re connecting to an existing network, you may be able to get information about the
network and the network software you need from a network administrator who oversees its
operation. Identify your organization’s network administrator before you begin.
Follow these guidelines when selecting a cable for your network:
Type of twisted-pair Ethernet

Use twisted-pair cable types

10 Mbit

Category 3, 5, or 6

100/1000 Mbit

Category 5 or 6

Connecting to a Twisted-Pair Ethernet Network

You can connect directly to a 10/100/1000 twisted-pair Ethernet network.
Note: You can also connect your computer to an Ethernet network that uses thin coaxial cables.
To do this, you need an RJ-45–to–Thin Coax adapter (available from other manufacturers). See
your Apple-authorized dealer for more information on Ethernet media adapters.
To connect your Macintosh to a centralized 10/100/1000 twisted-pair Ethernet network,
follow these steps:
1

Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.
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2

Plug the other end of the cord into an RJ-45 wall outlet or external hub that is connected to a
twisted-pair Ethernet network.
Ethernet port
(Twisted-pair
Ethernet)

RJ-45 wall plate

Ethernet hub
or switch

Twisted-pair Ethernet cable

After you start up the computer, you need to configure the software for your network
connection. Your network administrator can provide the necessary information. You can also
get help configuring your network software using Mac Help (in the Help menu).
To configure your network settings:
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1

Choose System Preferences from the Apple (K) menu and open the Network pane.

2

Show Built-in Ethernet.

3

Click the TCP/IP tab and enter information about your network. The default setting is
Configure Using DHCP.

4

Click Apply Now.

5

Close the System Preferences panel.

Maximizing Ethernet Performance

Your computer performs best when the Ethernet port to which it is connected is set to
auto-negotiate. Ask your network administrator to verify this setting.
If you experience connection problems on your network, make sure your
network switch is set to auto-negotiate, if possible. If a switch’s port is not auto-negotiating,
your computer detects the appropriate speed but defaults to half-duplex mode. If the
switch’s port at the other end of the link is configured for full-duplex, a large number of late
events can occur on the link. If it isn’t possible to set the switch to auto-negotiate, then set
the switch’s port to half-duplex. For more information, see the documentation that came
with the Ethernet switch.
Important

Note: If you connect your computer directly to a configurable Ethernet switch, have your
network administrator disable spanning tree on that port. Otherwise your computer may
duplicate the AppleTalk address of another computer on the same network and both
network connections may become unreliable.
For more information on networking your Power Mac G4, go to AppleCare Service and
Support at www.apple.com/support
For More Information on Using Ethernet

Additional information, including setting up an Ethernet network or transferring files using
Ethernet, is available in Mac Help. Choose Mac Help from the Help menu and search for
“Ethernet” or “network.”
For information on networking products you can use with your Power Mac G4, go to the
Macintosh Products Guide at www.apple.com/guide
Using AirPort Wireless Networking
AirPort offers an easy and affordable way to provide wireless Internet access anywhere in the
home, at work, or in the classroom. Instead of using traditional cables, AirPort uses wireless
local area network (LAN) technology to provide wireless communication between multiple
computers. Through a wireless network you can set up access to the Internet, transfer files,
play multiplayer games, and more.
Your Power Mac G4 is AirPort-ready. The only thing you need to add is an AirPort Card. See
“Installing an AirPort Card” on page 84. You install the AirPort Card in a slot inside the
computer and connect it directly to the end of a built-in antenna cable. For instructions on
using your Airport Card, see the About Your Airport Card booklet that came with your card.
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How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a base station, which has
a physical connection to the Internet. AirPort technology works like a cordless telephone.
The handset of the cordless phone makes a wireless connection to the base, which is
connected to the telephone line. Similarly, your computer makes a wireless connection to
the base station, which is connected to the telephone line or your Ethernet network.

Telephone or Ethernet connection

AirPort Base Station

Wireless Network Connections

If you install an AirPort Card, you can
m connect your computer to a computer network that has wireless access
m use your computer to provide network access for other computers using wireless cards
m establish a wireless connection and share information with another computer that has an
AirPort Card
Check with your network administrator for more information about reaching the network’s
wireless access point.
Warning Several kinds of objects placed near the computer can cause interference. See
the instructions that come with an AirPort Card or AirPort Base Station to learn about
avoiding interference. For more information, go to AppleCare Service and Support at
www.apple.com/support
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For More Information on AirPort

To purchase an AirPort Card or AirPort Base Station, contact your Apple-authorized dealer or
go to the Apple Store at www.apple.com/store
Additional information on AirPort is available in the online help. Choose Help Center from
the Help menu and click AirPort Help. You can also find information in the instructions that
came with your Airport Card or on Apple’s AirPort Web site at www.apple.com/airport
Putting the Computer to Sleep to Save Energy
Power Mac G4 computers are set to go to sleep after a period of inactivity. Sleep is a state in
which your computer uses very little power. You can also put the computer to sleep
whenever you want.
Note: Power Mac G4 computers are automatically set to sleep after 20 minutes of inactivity.
When the computer goes to sleep, it saves its state so that when you wake the computer,
your programs, documents, and computer settings are exactly as you left them. To save more
energy, shut down the computer or turn off the power strip when the computer is not in use.
To put your computer to sleep, you can do any of the following:
m Press the power button on the front of the computer.
m Choose Sleep from the Apple (K) menu.
m Set a sleep timer in your computer’s sleep settings by choosing System Preferences from
the Apple (K) menu and clicking Energy Saver.
When the computer is in sleep, the front panel power button light pulses.
To wake the computer, press the power button on the front panel of the computer, or press a
key on the keyboard. With some Apple monitors, you can also use the monitor’s power
button to put the computer to sleep and wake it.
Not all PCI cards or replacement AGP cards comply with the computer’s power management
standards. If you install a non-compliant card, the computer can still enter sleep mode, but it
will not achieve maximum energy saving. You can use the Apple System Profiler to find out
whether an installed card is compliant.
For more information about energy-saving options, see Mac Help.
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Attaching SCSI Devices to Your Computer
Some Power Mac G4 computer configurations come with an Ultra160 Dual Channel SCSI
card installed in a PCI slot with one or more internal SCSI hard disks connected to it. You
can install additional internal SCSI hard disk drives, up to a maximum of three drives. It’s
recommended that you only connect SCSI Ultra160 LVD hard disk drives to the internal port
of the Dual Channel SCSI card. You can connect external SCSI devices, including older drives
with slower data transfer rates, to the external port of the Ultra160 Dual Channel SCSI card.
Because the card has two channels, one connected to the internal port and another
connected to the external port, connecting older devices to the external port doesn’t slow
down the transfer rate of the internal hard disk drives.
Apple recommends that you use only SCSI Ultra160 LVD devices as internal hard disk drives.
To connect older SCSI devices that use a 25-pin or a 50-pin connector—such as Zip drives,
scanners, or DAT drives—you need to purchase SCSI adapters, or purchase and install an
additional “legacy” SCSI PCI card (one that supports older devices).
For more information about using different types of SCSI devices with your computer, go to
AppleCare Service and Support at www.apple.com/support
Transferring Information Between Two Macintosh
Computers
If two Macintosh computers are not connected by a network, you can transfer information
between them by connecting them with a standard category 5, 4 wire-pair (8 wires) Ethernet
cable (in effect creating a small network of just two computers), which you can buy from an
Apple-authorized dealer. You connect the cable to each computer’s Ethernet port and then
turn on file sharing on both computers. You can also configure the Ethernet settings on two
computers to create a small network.
First, turn on file sharing on both computers:
1

Choose System Preferences from the Apple (K) menu.

2

Open the Sharing pane.

3

Click Start to turn File Sharing on.
Next, follow these steps on one computer:

1

Choose Connect to Server from the Go menu.

2

Click Local Network.

3

Select the computer you want to access.
For more information about configuring Ethernet connections, search for “Ethernet” in
Mac Help.
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You can also connect two Macintosh computers using a FireWire cable. You can then use
FireWire target disk mode to transfer files from one computer to another. For more
information about using FireWire target disk mode, see “FireWire Target Disk Mode” on
page 54.
If you have an Internet connection, you can also transfer files via the Internet to your iDisk
storage area on iTools, where you or another iTools user can download them. For more
information about iTools, see “iTools—Free Internet Services for Mac Users” on page 26.
Using the Computer as a Server Without a Monitor
You can set up your computer to run as a server without an attached monitor. Follow
these steps:
1

Follow all the steps described in Chapter 1 to set up your computer, including connecting a
monitor, mouse, and keyboard.

2

Configure your server software as follows:
m Configure network access.
m Configure the security application so that the server can be controlled remotely.
m Set passwords for access to the server.
m Set network services to start up when the system starts up.

3

Be sure network services are operating properly.

4

Disconnect the monitor.
If you’re using remote access software, follow the instructions that came with your software
for logging in to and controlling the server.
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Working Inside Your Computer
This chapter provides information and instructions for working inside your computer.
Instructions are provided for the following procedures:
m “Opening the Computer” on page 68
m “Installing Memory” on page 70
m “Installing Internal Storage Devices” on page 72
m “Installing a PCI Expansion Card or Replacing the AGP Card” on page 80
m “Installing an AirPort Card” on page 84
m “Replacing the Battery” on page 85
Apple recommends that you have an Apple-certified technician install memory,
PCI expansion cards, and internal storage devices. Consult the service and support
information that came with your computer for instructions on how to contact an Appleauthorized service provider or Apple for service. If you install these items yourself, you
risk damaging your equipment, and such damage is not covered by the limited warranty
on your computer. See an Apple-authorized dealer or service provider for additional
information about this or any other warranty question.

Warning
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Opening the Computer
1

To shut down your computer:
m In Mac OS X, choose Shut Down from the Apple (K) menu.
m In Mac OS 9, choose Shut Down from the Special menu.
Wait five to ten minutes to allow the computer’s internal components to cool.
Always shut down your Power Mac G4 before opening it to avoid damaging its
internal components or the components you want to install. Do not open the computer or
attempt to install items inside it while it is turned on. After shutting down your computer,
the internal components can be very hot. Let the computer cool down before continuing.
Warning

2

Unplug all the cables from the computer except the power cord.

3

Touch the metal PCI access covers on the back of the computer to discharge any static charge.

Touch the metal
portion of the PCI
port access covers.

Always do this before you touch any parts, or install any components, inside
the computer. To avoid generating static electricity, do not walk around the room until you
have finished installing the expansion card, memory, or internal storage device and closed
the computer.
Important

4

Unplug the power cord.
Warning The power supply in your computer is a high-voltage component and should
not be opened for any reason, even when the computer is off. If the power supply needs
service, contact your Apple-authorized dealer or service provider.
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5

Lift the latch on the side of the computer.

Lift the latch to unlock
the side panel.

Note: If the latch won’t lift, check that the security lock port and lockable cover latch in the
back of the computer are not locked.
6

Gently lower the side panel onto a clean, flat surface, preferably onto a soft, clean cloth.

Gently lower the side
panel until it lies flat.
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Installing Memory
You can install additional dynamic random-access memory (DRAM) in packages called
Dual Inline Memory Modules (DIMMs) in the three DRAM DIMM slots on your computer’s
main logic board. You can expand your computer’s DRAM to a maximum of 1536 megabytes
(1.5 gigabytes). To check the amounts of DRAM installed, use the Apple System Profiler
(located in the Utilities folder, in your computer’s Applications folder).
If you install 512 MB DIMMs, they must have 256 megabit (Mbit) devices. You can also install
256 MB DIMMs that have 256 Mbit or 128 Mbit devices. You can install different size DRAM
DIMMs in any order in any DIMM slot. To check the compatibility of your DIMMs, see the
Macintosh Products Guide on Apple’s Web site: www.apple.com/guide
DIMMs must fit these specifications:
m “PC-133” Synchronous DRAM (SDRAM)
m 3.3 volt ( V )
m 64-bit wide, 168-pin module
m Maximum number of memory devices on a DIMM is 16.
m Unbuffered; do not use registered or buffered SDRAM.
m Height must not exceed 2.0 inches.
DIMMs from older Macintosh computers may not be compatible with your
Power Mac G4. Only “PC-133” DIMMs are compatible. Do not use older DIMMs even if they
fit into the DRAM DIMM slots.
Important

Note: When purchasing DRAM for use in Macintosh computers, make sure that the memory
vendor conforms to the JEDEC specification. Check with your memory vendor to ensure that
the DRAM DIMM supports the correct timing modes and that the Serial Presence Detect (SPD)
feature has been programmed properly, as described in the JEDEC specification. You can
purchase Apple-branded memory online from the Apple Store: store.apple.com
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1

Open the ejectors on the DRAM DIMM slots you want to use by pushing down on them.

2

Align a DRAM DIMM in the DRAM slot as pictured and push the DIMM down until the
ejectors snap into place.
Important

Do not touch the DIMM’s connectors. Handle the DIMM only by the edges.

DRAM DIMM (Your DIMM’s shape and components may vary.)
The DRAM DIMM is designed to fit into
Connectors
the slot only one way. Be sure to align the
notches in the DIMM with the small ribs
inside the slot. With the ejectors in the
open position (as shown), push down
on the DIMM until it snaps into place.
The ejectors will automatically close.
Ejector
(Your slot may have one or two ejectors.
They should be pushed outward and down
to be in the open position, as shown.)

3

Notches

DRAM slot (1 of 3)

Ribs (inside slot)

Close the computer.
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Installing Internal Storage Devices
Your Macintosh has five internal drive bays. Three are in the lower part of the computer and
two are in front on top. In many configurations, a single hard disk drive occupies a lower bay.
One of the upper bays contains an optical drive, and you can purchase and install an optional
Zip drive in the other upper bay.
You can add SCSI and ATA disk drives to the empty lower drive bays.
Drives must meet these specifications:
m Width: 3.9 inches (102 mm)
m Depth: 5.7 inches (147 mm)
m Height: 1.0 inches (ATA), 1.6 inches (SCSI)
The computer provides support for the following types of internal storage devices:
m ATA devices, including ATA, ATA-2, ATA-3, up to ATA-6 devices
m Ultra ATA devices
m Ultra-66 ATA devices
m ATAPI drives, including CD-ROM, CD-RW, DVD-ROM, DVD-R, and Zip drives
m Wide Ultra SCSI devices (requires an additional SCSI PCI card)
m Ultra2 and Ultra160 low-voltage differential (LVD) SCSI devices (requires a SCSI PCI card)
For more information about requirements and devices supported, see your Apple-authorized
dealer and the support section of Apple’s Web site: www.apple.com/support
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Installing Ultra ATA Drives

Your Macintosh can accommodate two internal 1-inch-high ATA devices in the U-shaped drive
carrier in drive position 3 in the computer. If your computer has one Ultra ATA drive, it sits in
the lower portion of this U-shaped drive carrier. You can install a second ATA device in the
upper part of the carrier.
The drive that came with your Macintosh is designated the “master drive” (sometimes called
“drive 0”). The ATA drive you add as a second drive is called the “slave drive” or “drive 1.”
1

Configure your drive as a slave drive by setting the appropriate jumpers. Contact your drive
manufacturer or consult the manufacturer’s Web site to determine the correct settings.
Note: Your Macintosh doesn’t work with Ultra ATA devices set for cable select mode.

2

Remove the power cord bundle and the ribbon cable from the drive.
Drive position 3
Drive position 2

Unplug the power cord
bundle from the hard disk
drive. The plug is held tightly
in place, so pull firmly.

Drive position 1
Unplug the ribbon cable
from the hard disk drive.
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3

Remove the low-profile attachment screw from the drive carrier and tilt the carrier up to
remove it from the computer.
Remove the attachment screw
to release the drive carrier.

Tilt the drive carrier up
and carefully pull it out
of the computer.
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4

Install the ATA drive in the U-shaped bracket.
Note: The tinted screws illustrated below indicate the four low-profile screws that come
in the computer’s accessory kit. The untinted screws show the screws that come with the
new drive.
Attach an additional ATA drive (1" high)
to the upper portion of the drive carrier
by screwing it into position on its sides.
Attach the two screws on this side first.

These two
tabs will
bend
inward as
you tighten
these two
screws.

ATA drives that are 1" high are attached
to the lower portion of the drive carrier
from the bottom.

Position the hard disk drive on the drive carrier so that the ribbon cable connector and the
power cord connector are accessible.

If you’re installing a drive in the lower part of the U-shaped bracket, use the low-profile
screws to attach the bottom of the drive to the carrier.
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5

Replace the carrier and drive.
Slide the hard disk drive into the
computer at an angle, and lower
it into position. Make sure the
two tabs on the underside of
the drive carrier engage the
slots on the floor of the computer.

Install the
attachment screw
to secure the drive carrier.

6
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Reinsert the low-profile attachment screw you removed from the carrier in step 3.

7

Reconnect the power cord bundles and the ribbon cable to the hard disk drives.
Plug the power cord bundles into
the hard disk drives. Be sure to
press them firmly into position.

Tuck the excess
power cord
bundle cable
around the
side of the
hard disk
drives.

Plug the end of
the ATA ribbon cable
back into the bottom
ATA drive. Plug the middle
connector into the top ATA drive.

8

Close the computer.
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Installing Ultra160 LVD SCSI Drives

If your Macintosh has an internal Ultra160 LVD SCSI drive, you can connect up to two more
internal Ultra160 LVD SCSI drives to the PCI card and cable inside the computer. This cable
has the required connectors and a built-in terminator, so you don’t need to add one.
Note: If your computer doesn’t have a SCSI hard disk drive, you need to install a SCSI PCI
card in your computer to connect SCSI hard disks.
The procedures for disconnecting and connecting a SCSI hard disk drive and for removing
and inserting drive carriers are nearly identical to those presented in the ATA drive installation
instructions on page 73. Follow the ATA drive instructions when installing a SCSI drive.
However, before installing your SCSI drive, note the following differences:
When you configure your SCSI hard disk drive

Assign a unique SCSI ID number to each new device. A single factory-installed drive uses
SCSI ID 0; a second factory-installed drive uses SCSI ID 1; and a third factory-installed drive
uses SCSI ID 2. The SCSI PCI card has been assigned ID 7. If you select one of these numbers
for a new drive, the drive will not work properly.
When you attach the drive to the carrier

If you’re installing a SCSI drive in a computer that came with one SCSI drive, install the new
drive in position 3 (see “Inside Your Power Mac—Your Computer’s Internal Expansion Options”
on page 18). Do not install a SCSI drive in the top position of the U-shaped bracket.
SCSI drives that are 1" high are
attached to the lower portion of
the drive carrier from the bottom.

SCSI drives that are 1.6" high are attached
to the lower portion of the drive carrier
by screwing it into position on its sides.

Position the hard disk drive on the drive carrier so that the ribbon cable connector
and the power cord connector are accessible.
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Note: The tinted screws in the previous illustration indicate the four low-profile screws that
come with the computer. The untinted screws in the following illustration show the screws
that come with the new drive.
Attach additional SCSI drives (1" or 1.6" high) to the two flat drive
carriers by screwing them into position from the bottom.

Position the hard disk drive
on the drive carrier so that
the ribbon cable connector
and the power cord connector
are accessible. Screw the drive
into position with the four screws
supplied with the drive.

When you replace the carrier and reconnect the drive cables
If your computer came with a SCSI hard disk drive installed in
drive position 1, and you are installing a SCSI hard disk drive
in drive position 2 or 3, put the ribbon cable on top of the drives.
You can tape the ribbon cable to the tops of the drives with
double-stick foam tape to make the cable lie flat.

Make sure all of the power
cord and ribbon cable
connectors are firmly attached
to all of the drives and to the
PCI SCSI card.

SCSI terminator

PCI SCSI card
The ribbon cable may attach to a different position on
the PCI SCSI card, depending on the card you have.
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Installing a PCI Expansion Card or Replacing the AGP Card
You can expand the capabilities of your Power Mac G4 by installing cards in its expansion slots.
The computer has five expansion card slots, four of which accommodate peripheral component
interconnect (PCI) cards and one that accepts an advanced graphics port (AGP) card.
AGP cards and PCI cards have different connectors, so you cannot insert a PCI card into the
AGP slot.
About AGP Cards

Your AGP card, installed in slot 1, provides the computer’s monitor port. Slot 1 is designed
specifically to accept AGP cards that have a 32-bit data width. This 66 megahertz (MHz) slot
accommodates 3.3 volt ( V ) AGP cards (see the illustration on page 82).
You can replace the card that came with the computer with an AGP 1X card, 2X card, or 4X
card. A replacement AGP card must have a driver compatible with the Mac OS.
About PCI Expansion Cards

Your Macintosh has four expansion slots, labeled 2, 3, 4, and 5, which accept PCI cards up
to 12 inches long. Some models come with a SCSI PCI card installed in one of these slots.
Install only expansion cards that come with Macintosh driver software and that comply with
the PCI 2.1 standard.
The PCI slots can accommodate mixed voltage (5.0 V, 12 V, or 3.3 V ) cards with 32-bit or
64-bit data widths and a 33 MHz frequency. You can add a 66 MHz card to a PCI slot if the
card can operate at the lower 33 MHz rate.
Warning Do not use cards that function only at 66 MHz in the PCI slots. Damage to your
equipment could result. If you have a 66 MHz card, check the card’s manufacturer to see
if it also works at 33 MHz.

Maximum power consumption for all five expansion slots (the four PCI expansion cards and
the AGP card) should not exceed 80 watts ( W ).
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Installing Your Card

Install an AGP card in slot 1 only. Install PCI expansion cards in the slots labeled PCI 2, 3, 4,
and 5.
1

Remove the screw that holds the port access cover in place, pull out the access cover, and set
it aside.
m To remove a card that’s installed in the computer, remove the screw that holds the card in
place and pull the card from the slot.

Remove the screw that
holds the port access
cover in place.
Port access cover

If you need to
remove the card in
the AGP slot, press this
tab to release the catch.

2

Remove the card that you want to install from its static-proof bag and hold it by its corners,
taking care not to touch the gold connector or any of the components on the card.
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3

Align the card’s connector with the expansion slot and press down until the connector is
inserted all the way into the slot.
If you’re installing a 12-inch card, make sure the card engages the appropriate guide at the
front of the computer.

Reinstall the screw to
secure the card in place.
Port access opening
PCI slot

If the PCI card you
are installing is full-length
(12 inches), make sure it fits
in one of these five card guides.
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Press the card gently but firmly until the connector is fully inserted.
m Don’t rock the card from side to side; instead, press the card straight into the slot.
m Don’t force the card. If you meet a lot of resistance, pull the card out. Check the
connector and the slot for damage or obstructions, then try inserting the card again.
m Pull the card gently to see if it is properly connected. If it resists and stays in place, and if
its gold connectors are barely visible, the card is connected.
4

Reinsert the port access cover screw and tighten it to hold the card in place.
If you removed a card from your computer and did not install a replacement,
be sure to place a port access cover over the empty slot. Do not leave an empty slot
without a cover. An uncovered slot can affect the air flow that cools the computer’s
internal components and cause damage.
Warning

5

Close the computer.
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Installing an AirPort Card
1

Position the AirPort Card with the AirPort ID numbers and bar code facing up and insert the
card into the AirPort Card connector.

AirPort Card connector

Insert the AirPort Card—bar
code side up—until it is firmly
seated in the connector.
Plug the antenna wire into the
hole in the end of the AirPort Card.

2

The antenna wire is stowed
here when not in use.

Carefully attach the coaxial antenna wire to the port on the end of the AirPort Card.
The antenna wire is stowed on the side of the PCI card guide. Don’t bend or crimp the
wire tightly.

3
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Close the computer.

Replacing the Battery
Your computer has a 3.6 V lithium battery installed on the main logic board. Some signs that
you need to replace the battery are intermittent problems starting up the computer and
random changes in its date and time settings. You can purchase a replacement battery from
an Apple-authorized dealer.
1

Remove the battery from its holder, noting the orientation of the battery’s positive end. (A
plus sign is marked on and near the battery holder.)
Batteries contain chemicals, some of which may be harmful to the environment.
Please dispose of used batteries according to your local environmental laws and guidelines.
Important

Remove the battery by pulling it
up and out of its holder. You may
need to spread these two tabs
slightly apart to release the battery.
Spread the tabs gently so they
don’t break.
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2

Insert the new battery in the holder, making sure the battery’s positive symbol aligns with
the positive symbol on or near the holder.
Warning Installing the battery incorrectly may cause an explosion. Be sure the battery’s
positive and negative poles are correctly oriented in the holder. Use only the same type of
battery or an equivalent recommended by the manufacturer of the original.

3
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Close the computer.
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Troubleshooting
If you have a problem while working with your computer, here are some things you can try
right away.
Note: If you have problems in the Classic environment, troubleshoot them as you would in
Mac OS 9, not Mac OS X.
If the computer won’t respond or the pointer won’t move:

First, make sure the mouse and keyboard are connected.
m Unplug and then plug in the connectors and make sure they are firmly seated.
Then try to cancel what the computer is doing.
m Press the Command (x) and Q keys at the same time to try to quit the current application.
m Press the Command (x) and period keys at the same time and, if a dialog box appears,
click Cancel.
m In Mac OS X, choose Force Quit from the Apple (K) menu and select the application.
Restart the computer by choosing Restart from the Apple (K) menu to be sure the
problem is entirely cleared up. You can also press the Esc, Option, and Command (x)
keys at the same time.
m In Mac OS 9, hold down the Esc, Option, and Command (x) keys to force the application
to quit. Restart the computer by choosing Restart from the Special menu to be sure the
problem is entirely cleared up.
m If that doesn’t work, hold down the power button on the front of the computer for
five seconds. After the computer turns off, press the button again to turn it on.
m If all else fails, unplug the power cord to turn the computer off, then replug the power
cord and use the front panel power button to restart the computer.
m If the problem occurs only when you use a particular program, check with the
program’s manufacturer to see if it is compatible with your computer.
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m If the problem occurs frequently, choose Mac Help from the Help menu.
m In Mac OS X, search for “solve problems.”
m In Mac OS 9, look at the section on how to prevent and solve problems. You may also
need to check for extension conflicts or reinstall your computer’s system software.
If the computer freezes during startup or you see a continuous flashing
question mark for more than a minute:

If you are starting up in Mac OS 9, turn off your Mac OS 9 system extensions.
m Start up your computer while holding down the Shift key.
m If your computer is set to start up from another computer on your network, check that
your Ethernet cables are firmly connected, then restart your computer. Your computer
may be having trouble connecting to the network. Check that the startup computer or
server is not down.
m If you are in Mac OS 9, remove any items from the Servers folder in your System Folder.
Your computer may be having trouble connecting to a server over the Internet.
If that does not work, or if you are starting up in Mac OS X, turn off the computer by holding
down the power (®) button. Then start up using the Software Install CD.
m Insert your system software CD and start up while holding down the C key. (Make sure
the Caps Lock key is not engaged.)
m After the computer starts up, see the troubleshooting information in the onscreen help.
Choose Mac Help from the Help menu. Look at the section on how to prevent and solve
problems. You may need to check for extension conflicts or reinstall your computer’s
system software.
If the computer won’t turn on or start up:

First, make sure the power cord is connected to a working power source.
m The plug on the power cord must be completely inserted into the computer’s power
socket and firmly seated for your computer to operate correctly.
Reset the computer’s parameter random-access memory (PRAM).
m Start up the computer and immediately hold down the Command (x), Option, P, and R
keys until you hear the startup sound a second time. Then set your hard disk as the
computer’s startup disk.
m In Mac OS X, choose System Preferences from the Apple (K) menu and click Startup
Disk, then select your hard disk.
m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Startup
Disk from the submenu, and select your hard disk.
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If you hear tones during startup:

m If you recently installed additional memory, a PCI expansion card, or other internal
component, make sure that it is correctly installed and that it is compatible with your
computer. See if removing it allows the computer to start up.
m Contact an Apple-authorized service provider.
If you are unable to eject a disc:

A file on the disc may be in use. Quit applications that are open, then try again.
If that doesn’t work:
m In Mac OS X, choose Restart from the Apple (K) menu and hold down either the mouse
button or the Media Eject (C) key on your Apple Pro Keyboard.
m In Mac OS 9, choose Restart from the Special menu and hold down either the mouse
button or the Media Eject (C) key on your Apple Pro Keyboard.
Software Problems
If you have a problem with a software program:

m Use Software Update to ensure that you have the latest drivers, bug fixes, and other updates.
m For problems with software from a manufacturer other than Apple, contact the
manufacturer.
If you have a problem using your computer or working with the Mac OS:

m Look at the Help Center (in the Help menu) for instructions and troubleshooting
information.
m Go to the Apple Support Web site on the Internet for the latest troubleshooting
information and software updates: www.apple.com/support
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If you have trouble using AirPort wireless communication:

m Make sure you have properly configured the software according to the instructions that
came with your AirPort Card or AirPort Base Station.
m Make sure the computer or network you are trying to connect to is running and has a
wireless access point.
m Make sure you are within antenna range of the other computer or the network’s access
point. Nearby electronic devices or metal structures can interfere with wireless
communication and reduce this distance. Repositioning or rotating the computer may
improve reception.
m See AirPort Help (in the Help Center) and the instructions that came with the wireless
device for more information.
Problems With Your Display
Warning If you have a problem with your Apple display and nothing presented in this
manual solves it, contact an Apple-authorized service provider or Apple for assistance.
If you attempt to repair the display yourself, any damage you may cause to the display
will not be covered by the limited warranty on your display. Contact an Apple-authorized
dealer or service provider for additional information about this or any other warranty
question.
No image appears on the screen.

m Make sure the display and computer are turned on.
m Make sure the cables are connected properly to your computer and the display.
m Make sure your computer is not in sleep. Press the power button or any key to see if the
computer wakes.
m Make sure the display brightness and contrast are set properly. Some monitors have
brightness and contrast controls on or under their front edge.
m Reset the PRAM by restarting the computer while holding down the Command (x),
Option, P, and R keys until you hear the startup sound a second time. Then start up using
the Software Install CD.
m If that doesn’t work but your display is functioning, then it is a software problem. Restart
your computer while pressing the Shift key to restart with your extensions off.
The screen image appears dim or flickers.

m Adjust the display brightness and contrast settings. Some monitors have brightness and
contrast controls on or under their front edge. Depending on how dim your monitor
appears, you may be able to adjust brightness or contrast using the Display pane of
System Preferences (in Mac OS X) or the Monitors control panel (in Mac OS 9).
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m Calibrate the monitor.
m In Mac OS X, choose System Preferences from the Apple (K) menu, click Display,
select Color, and click Calibrate.
m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Monitors
from the submenu and click Calibrate. The Calibrate option is not available on some
displays.
m The flickering may be caused by interference from a nearby power line, a fluorescent light,
or an electrical device—for example, a radio, a microwave oven, or another computer. Try
relocating nearby electrical devices or moving your computer and display.
No colors appear on the screen or the colors don’t look right.

m Make sure the display is connected firmly to the computer.
m Calibrate your monitor, as described previously. For more information on color and your
display, see Mac Help.
m Use the Display pane of System Preferences (in Mac OS X) or use the Monitors control
panel (in Mac OS 9) and make sure your monitor is set to display colors. For more
information on color and your display, see Mac Help.
After you change the screen resolution, desktop icons move.

m Changing the screen resolution affects the display of information on your screen.
The operating system may reposition icons after you change the screen resolution.
The screen freezes.

m Force the application that has frozen to quit.
m In Mac OS X, choose Force Quit from the Apple (K) menu and select the application.
m In Mac OS 9, hold down the Esc, Option, and Command (x) keys and click Force Quit
in the dialog box.
m If that doesn’t work, force the computer to restart by pressing the reset button (P) on
the front of your computer.
The light on the front of the monitor is flashing.

On some Apple flat panel displays, the power light displays a series of short flashes when an
error has been detected.
m If you see a repeating sequence of three short flashes, the monitor is detecting input in
the wrong video format. Check that your monitor is compatible with your graphics card
and that you’ve installed the correct monitor software, if your monitor came with
installation software.
m If you see a sequence of two short flashes and a long flash, the monitor is detecting a
problem with a backlighting lamp. Contact an Apple-authorized dealer or service provider.
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Restoring Your Computer’s Software
Apple Software Restore completely erases the contents of your hard disk or partition and
restores the original contents, including the original system software, factory settings, and
applications that came installed on your computer.
Should you need to restore your computer software, first back up essential software and
other files, if possible. This includes files you installed or created, such as personal
documents, access keys, preferences, Internet settings, fonts, system extensions, and
applications other than those that came installed on your computer.
Note: If you don’t want to erase the contents of your hard disk, you can reinstall just the
system software or certain applications using the Software Install CDs or application CDs that
came with your computer. For instructions on installing Mac OS 9 and Mac OS X, see the
Welcome to Mac OS X book.
Restoring your software completely erases your hard disk before restoring the
original software. Be sure to back up all your software files before restoring.
Warning

Before Restoring Your Software

Before you begin the restore process, do the following:
m Note customized settings and preferences: If possible, make a note of any preferences,
Web bookmarks, and settings in System Preferences (in Mac OS X) or in Control Panels
(in Mac OS 9) and applications so you can easily reset them after you restore your
software.
m Back up your data: This procedure completely erases the contents of your hard disk
before restoring the original factory settings and applications that came with your Power
Mac G4. Therefore, first back up your software and files.
Note: If you are working in Mac OS X and want to reinstall only your Mac OS 9 software,
restart your computer in Mac OS 9, then follow the directions for restoring your Mac OS 9
software. For information on changing your startup Mac OS, see “Switching Between
Operating Systems” on page 44.
It is highly recommended that you back up the data on your hard disk before
restoring software. Apple is not responsible for any lost data.
Important
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Restoring Your Software

When you restore Power Mac G4 software using the Software Restore CDs, your computer
starts up in the same Mac OS environment as when you purchased your Macintosh.
To restore your computer’s software:
1

Make sure you have all the Apple Software Restore CDs that came with your computer.

2

Insert Software Restore CD 1 into your drive.

3

Restart your computer, holding down the C key so the computer starts up from the CD.

4

Follow the instructions on the screen.
When you restart your computer after restoring your software, a Setup Assistant opens to
help you reconfigure settings.

5

If you reinstall your Mac OS using the Software Install CD, use Software Update for each
Mac OS you install to get the latest updates and drivers over the Internet. In Mac OS X, open
System Preferences and click Software Update. In Mac OS 9, choose Control Panels from the
Apple (K) menu, then choose Software Update from the submenu and click Update Now.
Note: If you want to use Classic in Mac OS X, you must also restore Mac OS 9 and install any
related software updates.
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Specifications
Processor and Memory Specifications
Processor

m PowerPC™ G4 processor with 256 kilobytes (KB) on-chip cache
m Some configurations have 2 megabytes (MB) L3 backside cache per processor.
Random-Access Memory (RAM)

m Synchronous Dynamic Random-Access Memory (SDRAM) up to a maximum of
1536 MB (1.5 GB)
m All SDRAM is supplied in removable Dual Inline Memory Modules (DIMMs).
m Three slots are available for DIMMs that are
m “PC-133” SDRAM DIMMs
m 128, 256, or 512 MB DIMMs
256 MB DIMMs must have 128 or 256 megabit (Mbit) technology devices; 512 MB DIMMs
must have 256 Mbit technology devices.
m 3.3 volt ( V ) unbuffered, 64-bit wide, 168-pin
The Mac OS system software provides information about your computer, including the
amount of memory.
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Dimensions and Operating Environment
Dimensions

m Weight: 15.9 kg, 35 lbs.
Weight depends on configuration. Weight above includes basic configuration, optical
drive, Zip drive, and one hard disk drive. Weight may be greater if optional devices are
installed.
m Height: 432 mm, 17.0 in.
m Width: 227 mm, 8.9 in.
m Depth: 468 mm, 18.4 in.
Operating environment

m
m
m
m

Operating temperature: 10° to 35° C (50° to 95° F)
Storage temperature: –40° to 47° C (–40° to 116.6° F)
Relative humidity: 5% to 95% (noncondensing)
Altitude: 0 to 3048 meters (0 to 10,000 feet)

CD-RW Drive Specifications

m Disc diameters supported: 12 cm (4.7 in.)
Data formats

m
m
m
m
m
m
m
m
m
m
m
m
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CD-ROM
CD-Audio
CD-R
CD-RW
CDI
CD Bridge
CD Extended
CD Mixed Mode
Photo CD
Video CD
3-inch circular CD (6.75 cm)
non-circular CDs

Combo Drive (DVD-ROM/CD-RW) Specifications

m Disc diameters supported: 12 cm (4.7 in.)
Data formats

m
m
m
m
m
m
m
m
m
m
m
m
m

CD-ROM
CD-Audio
CD-R
CD-RW
CDI
CD Bridge
CD Extended
CD Mixed Mode
Photo CD
Video CD
DVD-Video
DVD-ROM
DVD-R (read only)

SuperDrive (DVD-R/CD-RW) Specifications

m Disc diameters supported: 12 cm (4.7 in.), 6.75 cm (3 in.)
Data formats

m
m
m
m
m
m
m
m
m
m
m
m
m
m

CD-ROM
CD-Audio
CD-R
CD-RW
CDI
CD Bridge
CD Extended
CD Mixed Mode
Photo CD
Video CD
non-circular CDs
DVD-Video
DVD-ROM
DVD-R
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USB Specifications

m
m
m
m

Support for USB 1.1
Two external Universal Serial Bus (USB) Type A ports
Each port is on a separate 12 megabit per second (Mbps) USB channel.
500 milliamperes (mA) at 5 V are available per port for a total of 1 ampere.

FireWire Specifications

m Data transfer speed: 100, 200, and 400 Mbps
Power

m
m
m
m

Input voltage range: 8 to 33 V
Input power: Approximately 1 watt ( W )
Output voltage range: Approximately 13 to 30 V
Output power range: Up to 15 W

Ethernet Specifications

m
m
m
m
m
m
m
m

IEEE 802.3 compliant
Maximum cable length: 100 meters (m)
Protocols: Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP
Connector: RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T
Media, 10Base-T: Category 3 or higher UTP on 2 pairs up to 100 m
Media, 100Base-TX: Category 5 UTP on 2 pairs up to 100 m
Media, 1000Base-T: Category 5 and 6 UTP on 4 pairs up to 100 m
Channel speeds: IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Modem Specifications

m Data communications standard: K56Flex and V.90
m Speed: 53 kilobits per second (Kbps)
m Fax standard: ITU V.17
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Specifications for the AirPort Card (Optional)

m
m
m
m

Wireless data rate: Up to 11 Mbps
Range: Up to 168 feet (data rates may vary depending on environmental conditions)
Frequency band: 2.4 gigahertz (GHz)
Radio output power: 15 dBm (nominal)

Compatibility

m 802.11 Direct Sequence Spread Spectrum (DSSS) 1 and 2 Mbps standard
m 802.11 HR DSSS 11 Mbps standard
Audio Output Specifications

m 16-bit stereo sound with audio sampling rates of 44.1 kilohertz (kHz)
Sound out using the Apple speaker mini-jack

m Compatible with only Apple Pro speakers; other speakers should not be used.
Sound out using the headphone jack

m Full-scale output level: 3.0 V peak-to-peak with an 8 kilohm load
Noise, distortion, and bandwidth

m Output sound signal-to-noise ratio (SNR) less than 80 decibels (dB) unweighted (typical)
m Distortion: Total harmonic distortion: 0.08 percent
m Bandwidth: 20 hertz (Hz) to 20 kilohertz (kHz)
Graphics Controller

m AGP card with Apple Display Connector and VGA connector
Video Display Modes

For technical specifications for your specific display, go to the Apple Web site and check the
specifications for your product: www.apple.com/store
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Power Supply
AC line input

m Line voltage/current: 100–120 V alternating current (AC), 8 amperes (A) or 200–240 V AC,
4.5 A, single phase, manually set by voltage selector switch or set automatically depending
on the type of supply
m Frequency: 50–60 hertz (Hz)
DC monitor output

m 4.0 A maximum at 25 V DC from the Apple Display Connector
Power Requirements for Devices You Can Connect
Expansion cards

m Maximum power consumption by the AGP card is 20 W.
m Maximum power consumption by four PCI cards and the AGP card combined is 80 W.
USB devices

m Each of the computer’s built-in USB ports is allotted 500 mA.
FireWire devices

m The computer can provide up to 15 W total to the FireWire ports.
System Clock and Battery

m CMOS custom circuitry with long-life lithium battery. You can replace the computer’s
battery (see “Replacing the Battery” on page 85) with a new one purchased from an
Apple-authorized dealer.
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Safety, Maintenance, and Ergonomics
This appendix provides important information about safety procedures, routine
maintenance, and ergonomic considerations for using your computer and display.
Important Safety Information
The only way to disconnect power completely from your computer is to unplug the power
cord from the main power supply. To disconnect your display completely, you must also
unplug its power cable from the computer or power outlet. Make sure at least one end of the
device’s power cord is within easy reach so that you can unplug the computer or display
when necessary.
For your own safety and that of your equipment, always take the following precautions.
Disconnect the power plug from your computer or display if any of the following
conditions exists:
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your computer or display is exposed to rain or any other excess moisture
m your computer or display has been dropped or the case has been otherwise damaged
m you suspect that your computer or display needs service or repair
m you want to clean the computer or display case or screen
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To prevent accidents and damage to your computer or display, be sure that you always follow
these instructions:
m Keep your computer and display away from sources of liquids and moisture.
m Don’t set anything on top of the computer or display.
m Keep the computer and display vents free from obstruction.
m Never remove the case from the monitor or open your computer when it’s running. You
could come in contact with hazardous voltage.
m During lightning storms, disconnect your modem from the phone jack to prevent a
destructive voltage overload from damaging the modem.
Your Macintosh is equipped with a three-wire grounding plug—a plug that has a third grounding
pin. This is a safety feature. Don’t modify the plug to fit into an ungrounded outlet. Contact a
licensed electrician to replace the outlet with a properly grounded one. Do not defeat the
purpose of the grounding plug!
Be careful when lifting or moving your computer or monitor. Be sure to use correct lifting
procedures, lifting with your legs. When carrying the monitor, make sure the monitor is
facing you. Don’t carry the monitor by its stand.
Electrical equipment may be hazardous if misused. Operation of this product by children
must always be supervised by an adult. Do not allow children access to the interior of any
electrical product and do not permit them to handle electrical cables.
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General Maintenance
If you need to clean the computer or display beyond wiping it down with a clean cloth,
follow these instructions:
1

Turn your computer and display off.

2

Disconnect the computer power cable from the electrical outlet or power strip. If your
display is connected to an outlet, disconnect it as well.

3

Disconnect the display’s cables from the computer.

4

Clean the display screen with soft, lint-free paper or cloth dampened with mild soap and water.
Do not spray liquid directly onto the display screen. Liquid could drip inside
the display and cause electrical shock.
Warning

5

Wipe the computer or display case surfaces lightly with a clean, soft cloth dampened with water.
Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage the finish
on the case.
Protecting Your Optical Drive

To keep your optical drive working properly:
m Position your computer so that the drive tray doesn’t bump into anything when it opens.
m Close the drive when you’re not using it.
m Do not put anything on the drive tray when it is open.
m Do not touch the lens with your fingers. Do not wipe the lens with a paper towel or other
abrasive surface. If you need to clean the lens, see an Apple-authorized service provider
for a lens cleaner.
m Keep your computer away from any source of moisture.

Safety, Maintenance, and Ergonomics
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Maintaining Your Display

To maintain your display and ensure its long life:
m Do not press on the surface of the display screen.
m Do not write on the screen or touch the screen with a sharp object.
m If you will not be using your display and computer for a day or more, turn off the
computer and display or use Energy Saver.
m Turn off your monitor, turn down the brightness, or use a screensaver program that dims
or varies the image on the screen when the computer is idle for a prolonged time.
Important Ergonomic and Health-Related Information
Here are some guidelines for adjusting the furniture in your office to reduce glare and to
accommodate your physical size and shape.
m An adjustable chair that provides firm, comfortable support is best. Adjust the height of
the chair so your thighs are tilted slightly and your feet are flat on the floor.
The back of the chair should support your lower back (lumbar region). Follow the
manufacturer’s instructions for adjusting the backrest to fit your body properly.
m When you use the computer keyboard, your shoulders should be relaxed. Your upper arm
and forearm should form an approximate right angle, with your wrist and hand in roughly
a straight line.
You may have to raise your chair so your forearms and hands are at the proper angle to
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a
footrest with adjustable height and tilt to make up for any gap between the floor and your
feet. Or you can lower the desktop to eliminate the need for a footrest. Another option is
to use a desk with a keyboard tray that’s lower than the regular work surface.
m Position the mouse at the same height as your keyboard. Allow adequate space to use the
mouse comfortably.
m Arrange the monitor so the top of the screen is slightly below your eye level when you’re
sitting at the keyboard. The best distance from your eyes to the screen is up to you,
although most people seem to prefer 18 to 28 inches (45 to 70 cm).
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m Position the monitor to minimize glare and reflections on the screen from overhead lights
and nearby windows. If possible, use a tiltable monitor stand. The stand lets you set the
monitor at the best angle for viewing, helping to reduce or eliminate glare from lighting
sources you can’t move.
45–70 cm (18–28 in.)

Shoulders relaxed
Forearms and hands
in a straight line
Forearms level
or tilted slightly
Lower back supported

Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
display by placing something
under it or by raising your
work surface.)

Screen positioned to avoid
reflected glare
Clearance under work surface

Thighs tilted slightly
Feet flat on the floor

For more information about health, safety, and maintenance, go to Apple’s World Wide Web
site: www.apple.com/about/ergonomics
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Communications, Telephone, and Modem Regulation Information

For information on FCC regulations, radio and television interference, and telephone and modem information as
it relates to this product, see the files in the Communications Regulations folder, inside the Documents folder on
your hard disk.
Laser Information

Making adjustments or performing procedures other than those specified in your equipment’s
manual may result in hazardous radiation exposure.
Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.
If you have an internal Apple CD-ROM, DVD-ROM, or DVD-RAM drive in your computer, your computer is a Class
1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety
requirements. A service warning label is located in a service-accessible area. The labels on your product may differ
slightly from the ones shown here.

Warning

Class 1 label

Service warning label

Laser Specifications

Laser on pickup unit (when reading a CD)
m Type: Semiconductor GaAlAs laser
m Wavelength: 790 nm
m Power out of objective lens: 3.3 mW
m Beam divergence: horizontal 12º vertical 35º
Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits.
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact
during normal operation is minimized.
Mouse and Keyboard Information

The Apple optical mouse is a Class 1 LED product. This product complies with the requirements of European
Directives 72/23/EEC and 89/336/EEC.
It also complies with the Canadian ICES-003 Class B Specification.
High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or
communications systems, or air traffic control machines, or for any other uses where the failure of the computer
system could lead to death, personal injury or severe environmental damage.
ENERGY STAR® Compliance

As an ENERGY STAR® partner, Apple has determined that standard configurations of this product using the Mac OS X
and Mac OS 9 operating systems meet the ENERGY STAR® guidelines for energy efficiency. The ENERGY STAR®
program is a partnership with office product equipment manufacturers to promote energy-efficiency. Reducing
energy consumption of office products saves money and reduces pollution by eliminating wasted energy.
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